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  Operating Level Agreement (OLA) Template 
 
About this template 
This template provides a consistent format for all Operating Level Agreements (OLAs) between internal departments of ITS and 
a recognized IT customer requesting IT services(s). It addresses responsibilities and procedures for these internal departments, 
whose purpose is to provide IT services and support to the UCSC community.  The objective of the OLA is to present a clear, 
concise and measurable description of the services provided.  
 
The OLA template is maintained by ITSM. If you have suggested changes to the template, please contact name at phone #. 
 
How to use this template 

• Save this template under a new name before making any changes. 
 

To save the template under a new name 
 

1 On the File menu, click Save As. The Save As window opens. 
2 In the Save in box, select the location for the new file. 
3 Enter a new name in the File name box. 
4 Click Save. 

  
• Use only the sections of this document relevant to the SLA being addressed. Delete any non-relevant sections. 

 

• Delete any blue text during final revision. Blue text indicates instructional information.   
 

• Replace pink text with appropriate relevant text. Pink text also indicates a cross-reference you may need to modify or 
delete. Reformat pink text to black. 

 

• Do not revise red text. Reformat red text to black during final revision. 
 

• Delete the template watermark. 
 

To delete the template watermark 
 

1 On the View menu, click Header and Footer. The Header and Footer toolbar opens. 
2 In the document, select the template watermark. 
3 Press DELETE. 
4 Click Close in the Header and Footer toolbar. 

 

• Change the header to reflect the appropriate Service Provider. 
 

To change the header 
 
1 On the View menu, click Header and Footer. The Header and Footer toolbar opens. 
2 Select and delete the appropriate items from the header. 
3 In the Header and Footer toolbar, click Close. 

 

• Generate a new table of contents after final edits are made. 
 

To generate a new table of contents 
 

1 Right-click in the Contents. A context-sensitive menu appears. 
2 Select Update Field. The Update Table of Contents window opens. 
3 Select Update entire table. 
4 Click OK. The Contents is updated. 

 

• Select this instructional page and press DELETE.
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1 General Overview 
 

This document represents an Operational Level Agreement (“OLA”) between the service providers to document 
the working relationships and response times for supporting [service name from service catalog or elsewhere] 
(“The Service”). This OLA shall remain valid until revised or terminated.  

 
The purpose of this Operational Level Agreement (“OLA” or “Agreement”) is to ensure that the proper 
elements and commitments are in place to provide consistent service support and delivery to the Customer(s) by 
the Service Provider(s). 
 
The goal of this Agreement is to obtain mutual agreement for service provision between ITS units. 
 
The objectives of this Agreement are to: 

 
• Provide clear reference to service ownership, accountability, roles and/or responsibilities. 
• Present a clear, concise and measurable description of service provision to the customer. 
• Match perceptions of expected service provision with actual service support & delivery. 
 

Include / revise Purpose, Goal and/or Objectives relative to the specific goals and/or services of the 
organization.  
Tip: Complete other parts of this template and come back to this section for specific goals and objectives. 

2 Parties Responsible 
2.1 Stakeholders 
List all relevant contact persons, for example: 
The following Service Provider(s) will be used as the basis of the Agreement and represent the primary 
stakeholders associated with this OLA: 

 
Stakeholder Title / Role * Contact Information 
[Stakeholder 1] [Title / Role] [Contact Information] 
[Stakeholder 2] [Title / Role] [Contact Information] 

 
*NOTE: Availability is defined in Section 4, Hours of Coverage, Response Time & Escalations. 
Phone numbers are not to be used during off-working hours unless specified in this section. 

3 Service and Charges 
3.1 Scope 

Place the technical description of the service here. 
 

3.2 Customer Requirements 
 

Customer responsibilities and/or requirements in support of this Agreement include: List Customer 
responsibilities and requirements. 

 
3.2.1 General 

• Adherence to any related policies, processes and procedures outlined in xxx 
• Advanced scheduling of all service related requests and other special services with the Service 

Provider. 
• Payment for all service-related setup and/or configuration costs prior to service provision. 
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• Review related service hours logged by Service Provider for accuracy. 
• Review all service related reports distributed by the Service Provider. 
• Reasonable availability of customer representative(s) when resolving a service related incident or 

request. 
3.2.2 Standard Hours of System Operation (If applicable) 

 
3.2.3 Minimum System Stability Objectives (if applicable) 

 
3.2.4 Charges (if applicable) 

 
3.3 Assumptions 

• Services are clearly documented in the service catalog. 
• Major upgrades treated as a project outside the scope of this Agreement. 
• Funding for major updates will be negotiated on a service-by-service basis. 
• Changes to services will be communicated and documented to all stakeholders via XXX. 

4 Service Provider Requirements (Roles and Responsibilities) 
List Service Provider responsibilities; these can be categorized by department, application or specific to 
service parameters. 

 
Service Provider 1 responsibilities and/or requirements in support of this Agreement include:  
Service Provider 1 agrees to: 

• Meet response times associated with the priority assigned to incidents and service requests. 
• Generating quarterly reports on service levels for Customer. 
• Training required staff on appropriate service support tools. 
• Logging all Provider resource hours associated with services provided for review by the 

Customer, if applicable. 
• Appropriate notification to Customer for all scheduled maintenance via the Maintenance Calendar, 

Service Catalog web page and/or a communication to campus via Lisa Bono. 
• Facilitation of all service support activities involving incident, problem, change, release and 

configuration management. 
• Xx will perform blah 
• Xx will perform blah 

Service Provider 2 responsibilities and/or requirements in support of this Agreement include:  
Service Provider 2 agrees to: 

• Meet response times associated with the priority assigned to incidents and service requests. 
• Generating quarterly reports on service levels for Customer. 
• Training required staff on appropriate service support tools. 
• Logging all Provider resource hours associated with services provided for review by the 

Customer, if applicable. 
• Appropriate notification to Customer for all scheduled maintenance via the Maintenance Calendar, 

Service Catalog web page and/or a communication to campus via Lisa Bono. 
• Facilitation of all service support activities involving incident, problem, change, release and 

configuration management. 
• Xx will perform blah 
• Xx will perform blah 

 
Service Provider 3 responsibilities and/or requirements in support of this Agreement include:  
Service Provider 3 agrees to: 

• Meet response times associated with the priority assigned to incidents and service requests. 
• Generating quarterly reports on service levels for Customer. 
• Training required staff on appropriate service support tools. 
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• Logging all Provider resource hours associated with services provided for review by the 
Customer, if applicable. 

• Appropriate notification to Customer for all scheduled maintenance via the Maintenance Calendar, 
Service Catalog web page and/or a communication to campus via Lisa Bono. 

• Facilitation of all service support activities involving incident, problem, change, release and 
configuration management. 

• Xx will perform blah 
• Xx will perform blah 

5 Hours of Coverage, Response Times & Escalation 
This section validates the supported processes to manage service delivery. Exceptions are also documented. 

 
5.1 Work Requests (if applicable) 

Describe work requests related to this service. Application upgrades, OS Patches, architecture 
changes, etc. 
 

5.2 Service Request 
Clear and unambiguous definitions of how long it will take the parties to respond.  For example, if the 
OLA is between the Service Desk and the mainframe group, this section might include the definition of 
initial response to inquiry; time to review and evaluate; time to perform diagnostics; etc.  These times 
must align with the escalation times as well.  
In support of service outlined in this Agreement, the Service Provider will respond to service related 
incidents and/or requests submitted by the Customer within the following time frames:  

 
Outline how to request the service and expected response and deliver times. Outline working durations 
and customer/client interactions. This is not the service level but is key performance indicators (KPIs) 
that are monitored and reported on. Internal KPIs may or may not be translated into the metrics used 
for the SLA. The SLA will state the outer bounds of the service delivery timeframe and service related 
metrics. 

 
5.3 Incident Management 

 
Normal Incident Processing 
Service Providers supporting this service will prioritize incoming service incidents as normal priority unless 
the service incident fits one or more of the criteria listed in Subsection Major Incident Handling section. 

 

Service 
Provider 

Service Hours and Conditions Backup Contacted under 
what conditions 

Response Time 

Service 
Provider 1 

   

Service 
Provider 2 

   

 
 

Major Incident Handling 
This is a placeholder for the nearly ready major incident handling process. This section will be updated once 
the process is “blessed”. 
Service Providers supporting this service will prioritize incoming incident requests as “high” priority if it 
meets any one of the following criteria: 
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 Significant number of people affected. 
o Organizational structure is a multiplier for number of people affected. 

 Percentage of total tasks that can no longer be performed by individuals. 
 Academic and Administrative Calendar deadlines. 
 Significant impact on the delivery of instruction. 
 Significant or lasting impact on student academic performance. 
 Significant risk to law, rule, or policy compliance. 

 
It will be necessary to escalate this service to a high priority under these circumstances: 
Situation 1 (these can be spelled out here in list form or in the table only) 
Situation 2 
 

Service 
Provider 

Service Hours and 
Conditions 

Backup Contacted 
under what conditions 

Escalation Rules Response 
Time 

Service 
Provider 1 

  Situation 1  

Service 
Provider 2 

  Situation 2  

 
5.4 Problem Management 
This section is a placeholder for the problem management process. 
 
5.5 Service Maintenance/Change Management 

All services and/or related components require regularly scheduled maintenance (“Maintenance Window”) 
in order to meet established service levels. These activities will render systems and/or applications 
unavailable for normal user interaction for the following locations and timeframes: 
 

Location(s): [Location(s)] 
Timeframe(s): [Timeframe(s)] e.g.: 2:00 a.m., Sundays, U.S. Eastern time 

 
Time Sunday Monday Tuesday Wednesday Thursday Friday Saturday 
Begin        
End        

  
         Add additional locations and timeframes as required. For example, adding tables for standard 
maintenance or major upgrades/changes. 
 

5.6 Service Exceptions 
Any deviations from current policies, processes and standards are noted by the following Service 
Exceptions: (Insert any special exceptions related to coverage times and dates) 
 

Exception  Parameters Coverage 
Federal Holidays N/A No coverage 
Fiscal Year Close Last business day in 

May 
Additional coverage, 8:00 a.m. to 5:00 p.m. U.S. 
Eastern time 

Emergency service 
coverage 

Critical business need  Customer may request support by contacting the 
Help Desk during from 8am-5pm or xx from 5pm-
8am 
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6 Reporting, Reviewing and Auditing 
Any agreement requires oversight and reporting, and no agreement runs forever.  This section clearly defines 
the duration of the OLA, when and under what conditions to review the OLA, and when, what and to whom to 
report.  Also included in this section should be how Key Performance Indicators (KPIs) are reported on so that 
the OLA owner can track performance and if required take action before breaches occur.  
 
This Agreement is valid from the Effective Date outlined herein and is valid until the Date of Termination. 
The Agreement should be reviewed at a minimum once per fiscal year; however, in lieu of a review during any 
period specified, the current Agreement will remain in effect.  
 
The Designated Review Owner (“Document Owner”) is responsible for facilitating regular reviews of this 
document. Contents of this document may be amended as required, provided mutual agreement is obtained from 
the primary stakeholders and communicated to all affected parties. The Document Owner will incorporate all 
subsequent revisions and obtain mutual agreements / approvals as required.  

 
Designated Review Owner: [Document Owner] 
Review Period: [Review Period] e.g. “Annually” or “Quarterly” 
Previous Review Date: [Last or Previous Review Date] 
Next Review Date: [Next Review Date] 

 
KPIs for this service are listed through out Section 5. Reporting on KPIs will take place (daily, monthly, 
quarterly) and made accessible internally at location. 
 
This Agreement will be posted to the following location and will be made accessible to all stakeholders: 

 
Document Location: [OLA Directory and/or Location] 

 


